Sana’a University
Republic of Yemen

Sana'a University
Republic of Yemen

Basic Skills Development

Date: december 2008
‐1‐

Sana’a University
Republic of Yemen

‐2‐

Sana’a University
Republic of Yemen

Table of Content:

Basic Skills Development: Overview of the course ......................................... 5

Module 1: Overview, Introduction and Working in teams ................................ 7
Module 2: Data collection: Literature; questionnaire and active listening........... 8
Module 3: Data analysis: excel and coding arguments .................................. 10
Module 4: Reporting and writing ............................................................... 11
Module 5: Presenting............................................................................... 12
Chapters:
1)

The S.M.A.R.T-tool...................................................................... 13

2)

Working in teams ....................................................................... 15

3)

The LogFRAME............................................................................ 17

4)

Searching (for scientific literature) ............................................ 19

5)

The different types of scientific literature .................................. 23

6)

How to read a scientific article ................................................... 25

7)

Active Listening.......................................................................... 29

8)

Making a questionnaire .............................................................. 33

9)

How to conduct an interview...................................................... 39

10)

Excel: the basics......................................................................... 41

11)

Report writing ............................................................................ 59

12)

Plagiarism, referring, citing and falsification.............................. 63

13)

Presenting.................................................................................. 67
Annexes

‐3‐

Sana’a University
Republic of Yemen

‐4‐

Sana’a University
Republic of Yemen

Basic Skills Development: Overview of the course
When conducting research, academic or non academic, there are some skills one need to
have. One cannot just start conducting research without raising fundamental questions
like: What do I want to know? Why do I want to know this? How am I going to get to
know the thing I want to know? How am I going to present my findings? Etc…
This reader is an attempt to give you an introduction to the most basic skills. By no
means will this be a complete record on skills needed. For sure there will also be an
overlap with what you know already; in that case it will be an always welcome repetition.
The Basic Skills course contains 10 lectures, distributed over 5 modules. For each lecture
you will need to prepare by reading the literature. During the lectures some of the
contents of the literature will be dealt with, and following in each lecture some
assignments will need to be done, either individually or in groups.
This reader will first provide you an overview of the different modules and their
exercises, followed by the 12 chapters with the literature. Please bear in mind that this
collection of writings is far from complete, and is not an attempt to show you the way
thing should be done, it is just an attempt to show you a way how things could be done,
always keep asking the question: why?
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Module 1: Overview, Introduction and Working in teams
[1 lecture]
Content:
•
•
•
•

Overview of the contents of the course / planning
Why this course?
S.M.A.R.T. objectives
Working in teams

Reading:
• Chapter 1: the SMART tool
• Chapter 2: Working in teams
• Chapter 3: the LogFRAME (optional, supportive)

Assignment 1: formulate a personal objective (What do you want to learn in this course?)
for the next two weeks and have a group discussion on the formulation by using the
S.M.A.R.T. acronym.

Assignment 2: make a list of the different group roles and write down for each role what
knowledge and what skills one needs to have for this role.
Following, make groups and discuss for each role the knowledge and skills everyone of
the group had in mind for the roles (for example: does the team leader need to have
mainly knowledge on the content or on the functioning of group processes?). Discuss the
differences that you come across.
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Module 2: Data collection: Literature; questionnaire and
active listening
[3 lectures]
Lecture 1: Searching (+ library visit)
Content:
•

The difference between an encyclopedia, Wikipedia, web sources, journals and
books

•

Literature searching in library & online, special attention to the available
glossary’s

Reading:
•

Chapter 4: Searching (for scientific literature)

Assignment 3:
Look for annual rainfall data of a country of your own choice. See if you can find out what
the amount of rainfall in this particular country is. Search for multiple data from different
sources, both academic and non-academic. Compare the data acquired from the different
sources and following compare it to data collected by other students on other countries.
What are the differences, similarities between the data from different countries?

Lecture 2: Reading
Content:
•

Types of literature, what is a ‘good’ source? What makes a text scientific?

•

How to read scientific literature?

Reading:
•
•

Chapter 5: Different types of scientific literature
Chapter 6: How to read a scientific article?

Assignment 4: comparing two texts
Take a look (reading quickly) at the two text included in this reader (Annexes 1 and 2).
What are the goals? (why is it written/published?), what is the target group? (for whom
is it written/published?) and how does this show? (how is the material adapted to the
public in terms of layout and language?)
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Lecture 3: Making a questionnaire and active listening
Content:
•

How to gather data: Interview, listening and a questionnaire

Reading:
•
•
•

Chapter 7: Active listening
Chapter 8: making a questionaire
Chapter 9: how to conduct an interview

Assignment 5: conducting an interview, active listening and providing feedback
Form groups of three or four. Person one interviews person two about his/her
professional past (education, jobs etc.). After 10 or 15 minutes person three (and four)
will provide person one with feedback on how he/she paid attention, showed to be
listening, and responded (See chapter 7). After this swap roles until all have been
interviewed.
Assignment 6: setting up a questionnaire
If you were to set up a questionnaire in Sana, to find out more about the people’s water
consumption, how would you go about it? Describe what data you want to know and
formulate 10 sample questions for a questionnaire.
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Module 3: Data analysis: excel and gathered data
[2 lectures]
Lecture 1:
Content:
•

Getting to know and practicing the basics of Excel

Reading:
•

Chapter 10: Excel: the Basics

Assignment 7: Take the excel sheet (provided digitally) and practice the different
possibilities of Excel. You can do this by manipulating the data and let excel provide you
the averages (of the pH) and explore by trying the other formula functions.

Lecture 2:
Content:
•

Using excel with your questionnaire

Reading:
•

Chapter 10: Excel: the Basics

Assignment 8: Conduct the questionnaire as you prepared this for assignment 6 with all
the other students. Enter the results in an excel sheet and following analyze the result
making use of the possibilities you practiced in last session.
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Module 4: Reporting and writing
[2 lectures]
Lecture 1:
Content:
•
•

Writing a report, what is it? And, why to do it?
How to write a report? Basic structure of a report

Reading:
•

Chapter 11: Report Writing

Assignment 9: make a writing plan for a report, making use of texts of Annex 1 and 2
and at least one more new source.

Lecture 2:
Content:
•

Introduction to ethical concerns, introduce paraphrasing, fabrication, falsification
and plagiarism. How to make references

Reading:
•

Chapter 12: Plagiarism, referring, citing and falsification

Assignment 10: Write the report for which you made a writing plan in the last session,
make sure that it is brief (up to 2 pages) and make sure that you make the citations in
the ‘right’ way!
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Module 5: Presenting
[2 lectures, last used for presenting the overall assignment]
Lecture 1:
Content:
•

How to give an oral presentation?

Reading:
•

Chapter 13: Presenting

Assignment 11: Prepare a presentation on the basis of the paper that you wrote for the
previous lecture and explain in the presentation how this contributed to you overall
objective formulated in the first lecture.

Lecture 2:
Assignment: give the presentation to your colleagues and give each other feedback on
the presentations.

Evaluation of the course
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1) The S.M.A.R.T-tool
This chapter provides two supporting tools for working in, and working on project. First
the S.M.A.R.T. principle is explained, which can be used for the formulations of effective
goals questions and objectives. Secondly the LogFRAME will be introduced, which can
help you in a group process.

SMART Goals
At the start of any project it is wise to formulate a main goal, and sub-goals. A useful
tool for this goal formulation is the SMART tool. This acronym van be used to formulate
goals is a SMART way - specific, measurable, agreed upon, realistic and time-based. You
can use the SMART tool also during the project, to re-formulate goals, objectives and
questions
The acronym SMART has a number of slightly different variations, which can be used to
provide a more comprehensive definition for goal setting:
S - specific, significant, stretching
M - measurable, meaningful, motivational
A - agreed upon, attainable, achievable, acceptable, action-oriented
R - realistic, relevant, reasonable, rewarding, results-oriented
T - time-based, timely, tangible, trackable
When you next run a project take a moment to consider whether your goals are SMART
goals.
Specific: Well defined, clear to anyone that has a basic background knowledge
Measurable: Is the goals/question obtainable, can we ‘measure’ the completion?
Agreed Upon: Do all group members and other parties (for example your supervisors)
agree on the formulated goal?
Realistic: Can you achieve the goal within the availability of resources, knowledge and
time
Time Based: Do you have enough time to achieve the goal?
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2) Working in teams
Differentiation of roles within a team leads to better team organization and productivity.
As team size increases, the need to differentiate between the roles of individuals
increases. With time, the roles that team members naturally prefer tend to emerge.
However, early in the team development process, team productivity may be promoted
through the assigning and rotating of team roles. The characteristic behavior of a team
member, i.e., their role, in the context of the team, defines the way other team members
expect them to contribute to- and advance the objectives and goals of the team. All team
members are responsible for behaving in such a way as to further the objectives of the
team. All are responsible for completion of a quality product, inclusion of all team
members in the process, capitalizing on the strengths of all individuals and promoting an
environment where all team members acquire new skills and knowledge. Each team
should define the roles that will best pro-mote their team productivity. Example roles
include a team leader, a recorder/scribe, a facilitator and a liaison. Each role type is
described below.
Weekly rotation of team roles allows all members to learn new skills and to appreciate
the challenges inherent in each role. Some roles will be more comfortable than others.
Reflection by the team members on their experiences in the various roles strengthens
team understanding and communication.

Team Leader
A team leader exerts the greatest influence on the team and is responsible for the overall
project scheduling and deliverables. Effective leaders must change as the needs of the
team evolve. Additionally, leaders understand that their role involves both task roles
(managing tasks) and responsibilities associated with nurturing the emotional or people
component of the team (leading people).It is beneficial for a team to designate a
different “leader” for each meeting and rotate the leadership on a weekly basis.
Team leader responsibilities include, but are not limited to:
•
•
•
•
•
•

preparing of the meeting agenda, to be published and distributed at least a day in
advance;
sending a reminder of the meeting time and place to all team members;
ensuring that the meeting remains focused on the agenda;
encouraging participation by all team members;
establishing an environment that fosters creativity where team members are
respected, take risks and feel safe expressing their ideas;
furthering the overall goals and objectives of the team.

Recorder/Scribe
A recorder/scribe captures the team’s discussions in writing and documents decisions
made and action items assigned. S/he communicates team decisions consistently and in
a timely fashion. A team should designate a “recorder” for each meeting, and his/her
responsibilities include electronically publishing and distributing the conclusions reached
and action items assigned within 24 hours of the meeting.

Facilitator
A facilitator is responsible for ensuring that all team members’ opinions are expressed
and evaluated. Also, the facilitator keeps time during team meetings and assumes the
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lead responsibility for furthering team cohesion and camaraderie. As with the team
leader and recorder/scribe roles, the team designates a “facilitator” for each meeting. In
addition to the above duties, the facilitator is responsible for moving the meeting along
according to the established schedule.

Liaison
A liaison communicates with organizations outside of the team. S/he takes a lead role in
establishing contact, following up on commitments, obtaining information, etc.

Example of a meeting agenda
Meeting:
Chairman:
Recorder:
Date/Time:
AV:
Location:
Distribution:
#

Start

Duration

Description

Desired Result

Person
Responsible

Time
1

8:00a

0:00

Welcome and opening

Team leader

2

8:00a

0:05

Review and approval of agenda

Revise & Adopt

3

8:05a

0:05

Approval of previous meeting minutes

Vote

4
5
6
7
8
9

Next meeting

10

Close meeting

[Based on chapter 6 of guide available at http://itll.colorado.edu/GEEN1400/]
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3) The LogFRAME
(Supportive additional background reading)
The logical framework or logframe is an analytical tool used to plan, monitor, and
evaluate projects. It derives its name from the logical linkages set out by the planner(s)
to connect a project’s means with its ends. The logframe is only one monitoring and
evaluation tool and its use does not pre-empt the use of other evaluation tools such as
priority-setting or rate-of-return analysis.
The logframe was originally developed by the United States Department of Defense, and
adopted by the United States Agency for International Development in the late 1960s.
Since then, it has been applied and modified by many bilateral donors, including
Germany, the United Kingdom, the European Union, Canada, and Australia.
[Source: “Engendering the Logical Framework – Helen Hambly Odame, Research Officer,
ISNAR, August 2001 see: http://www.isnar.cgiar.org/gender/hambly.htm - International
Service for Agricultural Research]
Logical Framework (LogFRAME) has the power to communicate a project's objectives
clearly and simply on a single page. Its power comes from the ability to incorporate the
full range of views of all stakeholders of a project. LogFRAME is a tool for summarising
the key features of a project design at the time of project identification (what is it?)
during definition (what should we do?) and appraisal (should we do it?). It is an upfront planner which provides the Project Team with essential planning information for the
development of project plans.
LogFRAME is ideally suited for the definition and design of soft projects. Examples of soft
projects include:
•
•
•
•
•
•
•
•

Strategic Planning;
Corporate Restructuring;
Business Improvement Projects;
Quality Implementation Projects;
Business Planning;
Marketing Planning;
Methodology and Cultural Change Projects;
Commercialization Projects.

Such projects are termed soft because the deliverables of these projects are typically
abstract (i.e. cannot touch and feel the results).
LogFRAME can also be used on hard projects as these often do have a soft perspective.
Examples of hard projects include:
•
•
•
•
•

Heavy Engineering Projects (e.g. Ship Building);
Building Construction;
Installation of Computer Hardware;
Road and Bridge Construction;
Office Relocation/New Branch Office.
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Such projects are termed hard because the deliverables of these projects are typically
physical (i.e. can touch and feel the results).

The framework or structure behind the LogFRAME is a 4x4 matrix. That is, four rows and
four columns.
[Source: Project Management Solutions (Aust) Pty Ltd see:
http://www.pmsa.com.au/LogFrame.htm]

Worked out logFRAME questions
Goal

Objectives

Outputs

Summary
What is the overall
broader objective
to which the
project will
contribute?
What are the
specific objectives
which the project
shall achieve?

What are the
concrete outputs
envisaged to
achieve the
specific
objectives?
What are the
envisaged effects
and benefits of
the project?

Indicators
What are the
key indicators
related to the
overall goal?

Evidence
Where can we
find the
information for
the indicators?

Assumptions

What indicators
will show
whether the
projects subobjectives are
achieved?
What indicators
will show
whether the
projects
outputs are
achieved?

Where can we
find the
information for
the indicators?

What factors/
elements are
influencing the
process?

Where can we
find the
information for
the indicators?

What factors/
elements are
influencing the
process?

Where can we
find the
information for
the indicators?

What factors/
elements are
influencing the
process?

What
improvements
and changes will
be produced by
the project?
Activities

What are the key
activities to be
carried out and in
what sequence in
order to produce
the expected
results?

What indicators
will make
progress
visible?
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4) Searching (for scientific literature)
Boolean Operators
When using search engines, one can often specify searches using Boolean
Operators since almost all search engines use Boolean operators. Boolean
operators define the relationships between words or groups of words.
Use

To

AND

Narrow search and retrieve records containing all of the words it
separates.

OR

Broaden search and retrieve records containing any of the words it
separates. The | can be used instead of 'or' (e.g., 'mouse | mice | rat' is
equivalent to 'mouse or mice or rat').

NOT

Narrow search and retrieve records that do not contain the term
following it.

()

Group words or phrases when combining Boolean phrases and to show
the order in which relationships should be considered: e.g., '(mouse or
mice) and (gene or pseudogene)

Note: Search queries containing several operators search in the following order:
()
NOT
AND
OR

Some useful search engines
General science:
Scirus:
Google Scholar (beta):

[http://www.scirus.com/]
[http://scholar.google.com]

For an overview of more specific scientific search engines see the website of the
Wageningen University library:
[http://library.wur.nl/desktop/portals/general/]
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The essentials of Google search
Note: The following with explain the basics of searching with google. Please be aware
that google.com in not an academic search engine. It is the most frequently used search
engine for standard search in the web. Most scientific search engines, see above, use
searching technology similar to the one used by google.
[based on: www.google.com/help/basics.html]
Doing a search on Google is easy. Simply type one or more search terms (the words or
phrase that best describe the information you want to find) into the search box and
hit Enter on your keyboard.
Water

Google Search

In response, Google produces a results page: a list of webpages related to your search
terms, with the most relevant page appearing first, then the next, and so on.
Here are some basic tips to help you maximize the effectiveness of your search:
• Choosing search terms
• Capitalization
• Automatic "and" queries
• Exclusion of common words
• Word variations
• Phrase searches
• Negative terms
• I'm Feeling Lucky
Choosing search terms
Choosing the right search terms is the key to finding the information you need.
Start with the obvious – if you're looking for general information on Water, try water.
But it's often advisable to use multiple search terms; if you're interested in integrated
water
management than
with
either integrated,
water or management by
themselves.
integrated w ater management

Google Search

You might also ask yourself if your search terms are sufficiently specific. It's better to
search on water management Yemen than on water management. But choose your
search terms carefully; Google looks for the search terms you chose, so Yemen water
management will probably deliver better results than drinking water use and other
water use in Yemen.
Capitalization
Google searches are NOT case sensitive. All letters, regardless of how you type them, will
be understood as lower case. For example, searches for water, Water, and wAtEr will
all return the same results.
Automatic "and" queries
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By default, Google only returns pages that include all of your search terms. There is no
need to include "and" between terms. Keep in mind that the order in which the terms are
typed will affect the search results. To restrict a search further, just include more terms.
For example, to search for water management, simply type water management.
w ater management

Google Search

Automatic exclusion of common words
Google ignores common words and characters such as "where" and "how", as well as
certain single digits and single letters, because they tend to slow down your search
without improving the results.
If a common word is essential to getting the results you want, you can include it by
putting a "+" sign in front of it. (Be sure to include a space before the "+" sign.)
Another method for doing this is conducting a phrase search, which simply means putting
quotation marks around two or more words. Common words in a phrase search (e.g.,
"where are you") are included in the search.
For example, to search for the World Water Forum, 5th edition, use either search terms
below:
"w orld w ater forum 5"

Google Search

w orld w ater forum +5

Google Search

Word variations (stemming)
Google now uses stemming technology. Thus, when appropriate, it will search not only
for your search terms, but also for words that are similar to some or all of those terms. If
you search for water managerial aspect, Google will also search for water
management aspects, and other related variations of your terms. Any variants of your
terms that were searched for will be highlighted in the snippet of text accompanying each
result.
Phrase searches
Sometimes you'll only want results that include an exact phrase. In this case, simply put
quotation marks around your search terms.
"Virtual Water"

Google Search

Phrase searches are particularly effective if you're searching for proper names/concepts
("Virtual Water").
Negative terms
If your search term has more than one meaning you can focus your search by putting a
minus sign ("-") in front of words related to the meaning you want to avoid.
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For example, here's how you'd find pages about Yemen, filtering out touristic pages:
bass -music

Google Search

When you include a negative term in your search, be sure to include a space before the
minus sign.

And finally... "I'm Feeling Lucky"
After you've entered your search terms, you might want to try the I'm Feeling
Lucky button, which takes you straight to the most relevant website that Google found
for your query. You won't see the search results page at all, but if you did, the "I'm
Feeling Lucky" site would be listed on top.
For example, if you're looking for info on Sana University, just enter Sana
University and click I'm Feeling Lucky instead of the Google Search button. Google
will take you directly to "http://en.wikipedia.org/wiki/Sana'a_University."
Sana university

Google Search

I'm Feeling Lucky
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5) The different types of scientific literature
Scientists communicate the results of their research to other scientists primarily through
the scientific literature, which therefore constitutes a permanent repository of scientific
knowledge and a record of progress in scientific enquiry.
Different types of scientific literature exist, normally referred to as the primary,
secondary, tertiary and grey literature.
Primary literature refers to accounts of research carried out personally by The an
individual scientist or as collaboration by a group of scientists, which is published in a
peer-reviewed scientific journal. These accounts, commonly called ‘papers’, are written in
the particular format specified by the journal to which it is submitted for publication.
Normally journals require a paper to consist of a title, abstract, keywords, introduction,
material & methods, results, discussion, acknowledgements and references. Papers are
submitted to the journal editor who then asks a number of recognized experts in the area
of study addressed by the paper (called ‘referees’) to give an opinion on whether the
work reported presents new scientific information, and to report on the merits and
deficiencies of the work. On the basis of the referees’ reports, the editor may accept the
paper as it was submitted, or may require minor revision from the authors, or may
require major revision, or the paper may be refused outright. This formal reviewing
process is known as ‘peer review’. There are different types of journal that range from
international to regional to local and there are also systems that grade the importance of
journals on the basis of how often papers carried by the journal are cited in other
scientific papers (called the ‘impact factor’).
Most primary literature is published in scholarly journals, but some research is published
as monographs, theses or dissertations, conference papers and reports. In the world of
science, the contribution of an individual scientist to the advancement of knowledge is
usually gauged partly on the number of publications that the scientist has contributed to,
especially those published in international peer-reviewed journals with high impact
factors.
Secondary literature consists of publications that rely on primary sources for information.
Here it is not a requirement for the authors to have done the work themselves, since the
purpose of the publication is to summarize and synthesize knowledge in a specific area
for other scientists who already have an understanding of the topic; however, the
authors of secondary publications would normally have worked and published primary
literature in the area they are writing about. The secondary literature includes review
journals, monographic books and textbooks, handbooks and manuals. Although normally
written in a scientific style, secondary publications are not organized in the same way
that primary publications are; however, it is a universal requirement that they are fully
referenced and that most of these references are to the primary literature. Scientists use
the secondary literature to gain an overview of research areas that are close to or
relevant to their own, or to familiarize themselves with existing research in new topics on
which they plan to start working.
Tertiary literature consists of published works that are based on primary or secondary
sources and that are aimed at scientists who work in different areas from the subject
matter of the publication, or towards an interested but lay audience. Such publications
are normally written in a popular rather than a scientific style and while such publications
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may include a short bibliography, they do not usually include references to the primary
literature. Examples of the
tertiary literature include science magazines, newsletters, science articles in newspapers,
introductory textbooks and encyclopedias.
Grey literature refers to sources of scientific information that are not published and
distributed in the usual manner and which therefore may be difficult to obtain. Gray
literature includes theses and dissertations, technical reports with a limited distribution,
journals published by special interest groups that have a limited distribution, abstracts of
conference papers and conference proceedings that are only made available to
conference participants, Environmental Impact Statements, some types of Government
documents, working papers, and some types of online documents. Note that being
classified as ‘gray literature’ in no way implies that the publication has little scientific
merit, since some types of grey literature are rigorously peer reviewed and count as
primary literature; ‘grey’ refers more to the limited distribution and difficulty of accessing
the publication than to its content.
It is important to note that the form that a publication takes no guide to its classification
as primary, secondary or tertiary literature. For example, books may belong to any of
these three categories. A monograph that presents new ideas as a result of scientific
research that has been reviewed by a number of referees (usually called ‘readers’ in the
case of a book), will count as primary literature (in effect, a very long scientific paper),
whereas an encyclopedia or science magazine article, even if written by a Nobel
laureate, is still tertiary literature.
Another example is the case of conference proceedings. Papers presented at
international, regional or national conferences, workshops or symposia are considered as
primary literature if they are peer-reviewed and published, either as a book of conference
proceedings, or as a special issue of a scientific journal. On the other hand, abstracts of
papers presented at a conference, or the papers themselves, which have not been peerreviewed, do not count as primary literature even if they are published in book form. An
in-between case is that of conferences where the papers presented are published as
peer-reviewed ‘extended abstracts’ (in effect, long summaries of the work that may be
formatted in the same way as a journal paper). Normally, such papers present work that
is in an advanced stage but not yet complete to an audience of peers for comment and
criticism. Most such work is later published in full form in primary scientific journals.
The situation is further complicated by the Internet. Scientific information available on
the Internet ranges from absolute rubbish to high quality. There are very authoritative
looking sites that present completely wrong information, sometimes deliberately,
whereas at the other end of the spectrum, there are primary peer-reviewed scientific
journals that are published online (normally, but not always, with at least a limited print
edition as well). Professional looking websites are no guarantee of quality information.
Users of the Internet should very carefully evaluate the source, quality and accuracy of
any information that they plan to use.
[source:
http://home.um.edu.mt/biology/The%20different%20types%20of%20scientific%20litera
ture.pdf. ]
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6) How to read a scientific article
"Probably what you should learn if you are a graduate student is not a large number of
facts, especially if they are in books, but what the important problems are, and to sense
which experiments, work that has been done, probably aren't quite right."
James Watson, of Watson & Crick (DNA fame)

When students in the sciences are first faced with using the primary research
literature, the prospect sometimes seems overwhelming. Finding pertinent journal
articles often seems to involve a maze of abstracting journals, indifferent librarians,
missing volumes, CDroms from hell, and bound periodicals that refuse to flatten
themselves for photocopiers (no matter how hard you press on them, CPR-style). Even
once an article has been located--or, in the case of this class, provided--there is the
problem of reading it. The worst way to assimilate a research paper is to read it word for
word, title to literature cited, as if it were a textbook. This approach is a waste of time,
because perhaps as few as 1 in 4 articles that find their way into your hands should be
committed to your brain, and is deadly boring.
Before reading one word of an article, ask yourself: What am I looking for in this
article? Knowing what I do about the subject, what gaps need to be filled, what
knowledge needs to be expanded, and what controversial points need to be
corroborated? Generate expectations of a journal article before you read it. This will
help your analysis of the work in front of you, plus keep you more interested in the
material. Then what:

1. Read the authors' names. Where and with whom are they working? What is their
expertise? Names may mean little at first, but as you "wade through" a scientific
subject or topic you will find familiar names cropping up, and you will develop those
with whom you agree and those whom you question.
2. Read and digest the title. It should summarize the work of the article well, help you to
clarify your expectations of the paper, and it should be an attention-getter (if you are
reading the article, it has probably already accomplished that task!).

3. Read the abstract carefully and try to understand it (though it may be the densest prose
you will ever encounter). Abstracts are as difficult to read as they are to write, because
an entire publication must be summarized in an understandable way in only about 200
words. By now, you should have a good idea of what the paper is about and what you
have gotten yourself into. At this point, it may be obvious that the paper does not
answer your questions. If this is true, move on, but be conservative because the
authors' interpretation of the research presented in the abstract may not be the same as
yours after reading the full paper. Never cite an article after having read only the
abstract!
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4. Picture time--flip through the article and study the figures, illustrations, and tables,
including the legends. It will probably become necessary to consult the Methods and
Results section to clarify figures and understand the experimental design. If the article
is closely related to your research, closely examine the techniques described in the
Methods section. There may be problems there, but more likely there will be a new,
perhaps better, approach to your own research. It should be clear to you by now
whether this paper will be truly helpful. If so, now it is time to be critical (please, see
the note below about this word).

5. Read the Introduction and be sure the author knows the field, has adequately
researched past work, and understands where their work "fits into the
puzzle". Generally, the Intro and Literature Cited sections go hand-in-hand. Most
importantly, within the first paragraph or 2 of the Introduction the authors should have
made it very clear what their objectives for the research were, and what their paper will
tell you.
6. Check to see if the Results adequately and accurately describe the data presented in the
paper. Are there additional points that should have been brought up? Is there
something in the figures or tables that does not substantiate the authors' claims that
was not mentioned? Do the figures and tables clearly, succinctly, and attractively
present the results of the paper? Remember that great data presented clumsily or
sloppily will not be seen as great, only clumsy or sloppy.

7. Now read the Discussion. This is perhaps the most important section, because it is here
that the results (the "what" of the research) are explained. That is, here is where the
authors should [at least try to] explain "why" they saw what they saw. Beware of
unsubstantiated speculation, though do not fault, off-hand, the presentation of
hypotheses for future work or even expectations of findings from those future
experiments. On the other hand, there are authors who are prone to timidity,
understatement, or who are just plain invertebrate about their ideas. You should not be
left guessing, or left to fumble to your own conclusions because an author was unwilling
to take even a small step out onto a limb. As a moderate example of such understated
conclusions, Watson and Crick ended their historic presentation of the structure of DNA
with the sentence: "It has not escaped our notice that the specific pairing we have
postulated immediately suggests a possible copying mechanism for the genetic
material." In fact, the complimentary base pairing they presented was no less that a
quantum leap in our understanding of biological systems, in terms of both modern
biochemistry and evolution!

Bear in mind that the ultimate burden of assessing published material lies with
you, the reader. Take the time and energy to do this and you will gain more and be
further along that the person who depends on the author for interpretation. Having just
completed a critical reading and assimilation of a journal article pertinent to your work,
you should be able to paraphrase the significance of this paper with 3 or 4 sentences free
of technical jargon. You should also be able to both praise and criticize several points of
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the paper (this is important--see note below). A general rule of thumb, regarding what
goes where, when both reading and writing a scientific article is:

Title:

Short, succinct, eye-catching, all-encompassing

Abstract:

Summary of Methods, Results, and Discussion starting off with a
statement of why the research was done and with emphasis
on why the results are significant.

Introduction:

When was past work done, by whom, why was their work
important, what you plan to do in your paper, and why what you
did is important.

Materials and Methods:

How you did what you did and where you did it--nothing more.

Results:

What the data show you--nothing more.

Discussion:

Why the data show what they show, and how your analysis relates
back to your objectives from the Introduction.

Note: Some journals will allow the Results and Discussion sections to be combined. In this
case, the data should be divided up into logical groups, and for each group (generally
separated by a subheading) the What and the why are presented together.

A note on critiques: A critique "considers the merits and demerits of something and judges
accordingly" (Webster). When critiquing an article (or anything, really), remember that
there are positive points to be found, and made, about everything. To present only
negative criticism is wrong. Never forget to acknowledge that, while we all make
mistakes and do things incorrectly, we also all do things correctly sometimes. A pat on
the back can go a long way.

Finally, after having scanned the text intensively you have to make the judgment
whether to read the complete text in depth. In depth reading basically means reading the article
from stem to stem, every word. In depth reading demands a focused reader, and quite a lot of
time, for this reason it is wise to scan the text as mentioned above. It is always up to the
reader’s judgment to see whether the text demands an in depth read.

Based on: http://www.fiu.edu/~collinsl/Article%20reading%20tips.htm
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7) Active Listening
Hear What People Are Really Saying
Listening is one of the most important skills you can have. How well you listen has a
major impact on your job effectiveness, and on the quality of your relationships with
others.
We
We
We
We

listen
listen
listen
listen

to obtain information.
to understand.
for enjoyment.
to learn.

Given all this listening we do, you would think we’d be good at it! In fact we’re not.
Depending on the study being quoted, we remember a dismal 25-50% of what we hear.
That means that when you talk to your boss, colleagues, customers or spouse for 10
minutes, they only really hear 2½-5 minutes of the conversation.
Turn it around and it reveals that when you are receiving directions or being presented
with information, you aren’t hearing the whole message either. You hope the important
parts are captured in your 25- 50%, but what if they’re not?
Clearly, listening is a skill that we can all benefit from improving. By becoming a better
listener, you will improve your productivity, as well as your ability to influence, persuade
negotiate. What’s more, you’ll avoid conflict and misunderstandings – all necessary for
workplace success. )
Good communication skills require a high level of selfawareness. By understanding your personal style of
communicating, you will go a long way towards creating good
and lasting impressions with others.
The way to become a better listener is to practice “active listening”. This is where you
make a conscious effort to hear not only the words that another person is saying but,
more importantly, to try and understand the total message being sent.
In order to do this you must pay attention to the other person very carefully.
You cannot allow yourself to become distracted by what else may be going on around
you, or by forming counter arguments that you’ll make when the other person stops
speaking. Nor can you allow yourself to lose focus on what the other person is saying. All
of these barriers contribute to a lack of listening and understanding.
Tip:
If you're finding it particularly difficult to concentrate on what
someone is saying, try repeating their words mentally as they
say it – this will reinforce their message and help you control
mind drift.
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To enhance your listening skills, you need to let the other person know that you are
listening to what he or she is saying. To understand the importance of this, ask yourself
if you’ve ever been engaged in a conversation when you wondered if the other person
was listening to what you were saying. You wonder if your message is getting across, or
if it’s even worthwhile to continue speaking. It feels like talking to a brick wall and it’s
something you want to avoid.
Acknowledgement can be something as simple as a nod of the head or a simple “uh huh.”
You aren’t necessarily agreeing with the person, you are simply indicating that you are
listening. Using body language and other signs to acknowledge you are listening also
reminds you to pay attention and not let your mind wander.
You should also try to respond to the speaker in a way that will both encourage him or
her to continue speaking, so that you can get the information if you need. While nodding
and “uh huhing” says you’re interested, an occasional question or comment to recap
what has been said communicates that you understand the message as well.

Becoming an Active Listener
There are five key elements of active listening. They all help you ensure that you hear
the other person, and that the other person knows you are hearing what they are saying.
1. Pay attention.
Give the speaker your undivided attention and acknowledge the message.
Recognize that what is not said also speaks loudly.
o Look at the speaker directly.
o Put aside distracting thoughts. Don’t mentally prepare a rebuttal!
o Avoid being distracted by environmental factors.
o “Listen” to the speaker’s body language.
o Refrain from side conversations when listening in a group setting.
2. Show that you are listening.
Use your own body language and gestures to convey your attention.
o Nod occasionally.
o Smile and use other facial expressions.
o Note your posture and make sure it is open and inviting.
o Encourage the speaker to continue with small verbal comments like yes,
and uh huh.
3. Provide feedback.
Our personal filters, assumptions, judgments, and beliefs can distort what we
hear. As a listener, your role is to understand what is being said. This may require
you to reflect what is being said and ask questions.
o Reflect what has been said by paraphrasing. “What I’m hearing is…” and
“Sounds like you are saying…” are great ways to reflect back.
o Ask questions to clarify certain points. “What do you mean when you
say…” “Is this what you mean?”
o Summarize the speaker’s comments periodically.
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Tip:
If you find yourself responding emotionally to what someone
said, say so, and ask for more information: "I may not be
understanding you correctly, and I find myself taking what you
said personally. What I thought you just said is XXX; is that
what you meant?"
4. Defer judgment.
Interrupting is a waste of time. It frustrates the speaker and limits full
understanding of the message.
o Allow the speaker to finish.
o Don’t interrupt with counterarguments.
5. Respond Appropriately.
Active listening is a model for respect and understanding. You are gaining
information and perspective. You add nothing by attacking the speaker or
otherwise putting him or her down.
o Be candid, open, and honest in your response.
o Assert your opinions respectfully.
o Treat the other person as he or she would want to be treated.

Key Points:
It takes a lot of concentration and determination to be an active listener. Old habits are
hard to break, and if your listening habits are as bad as many people’s are, then there’s
a lot of habit-breaking to do!
Be deliberate with your listening and remind yourself constantly that your goal is to truly
hear what the other person is saying. Set aside all other thoughts and behaviors and
concentrate on the message. Ask question, reflect, and paraphrase to ensure you
understand the message. If you don’t, then you’ll find that what someone says to you
and what you hear can be amazingly different!
Start using active listening today to become a better communicator and improve your
workplace productivity and relationships.
[source: http://www.mindtools.com/CommSkll/ActiveListening.htm]
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8) Making a questionnaire
[source: http://www.action-research.com/uua/question3.html]

What Questions Are You Going to Pose?
Conducting An Effective Ministerial Search Survey
Prepared for the Unitarian Universalist Association
By Dr. Paul Riedesel

Composing a Written Questionnaire
A questionnaire is a very special kind of document. While it might seem like any
reasonable person could type out a bunch of questions, creating a good, user-friendly
instrument is very much a craft. You cannot separate the composition of questions
themselves from the physical formatting (word processing). We recommend that you
compose the document in questionnaire format from the very first draft.
The most user-friendly form is a "booklet" of 4 or 8 pages. That literally means printing
on both sides of 11x17 paper and folding in the middle. Any commercial printer can do
this, as can better office copiers. Single sheets in the middle (say for a 6-page survey)
have a way of getting lost.
There is no end to the rules-of-thumb and good habits used by professionals. Here are
some of the major ones.
• Use questions with fixed answer categories as much as possible. Insofar as your main
goal is to provide summary tables, you will want to avoid the necessity of analyzing and
coding open-ended remarks. On a printed questionnaire, the easiest thing for people to
do is to check boxes. This is better practice than having them circle numbers. You need
to figure out how to insert nice looking check boxes in whatever word processor you are
using.
• The answer categories must be exhaustive. That is, they need to cover all imaginable
possibilities. That does not mean you have to offer dozens of choices, but at least leave
an "other" option.
• If you only want one answer, say that explicitly. If several answers may be checked,
say that explicitly. Instructions, by the way, should be in a different font than the
questions and answers. Italics or bold will do it.
• Pre-number the answer categories. This aids greatly in correctly tabulating the results.
The numbers should be in a small, subscripted font.
• It is customary and useful to number the questions. This is essential if there are to be
any "skips" in the questionnaire. It will also make it easier for you when you are
tabulating the answers.
• Never split the answer categories across two pages!
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• Place the easier-to-answer questions at the beginning of the survey. Ones that require
more effort to answer, or that are more sensitive in nature (sexuality, or worst of all,
money), should appear later.
• Questions that are related to each other should be grouped together as much as
possible. Subject headings and brief introductions to the various sections can help.
Note that these categories are exhaustive and exclusive, that multiple answers are
explicitly
invited,
and that the check boxes are pre-numbered.

Here is a really bad question! Many of us could check several boxes, but is that what is
wanted?

Here is a much better version.

Certain data you wish to report may describe an entire household, rather than individual
members. You must take care to ask questions in such a way that you are accurately
describing households.
Here is a tidy solution.
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Question Skips
It is sometimes necessary to ask that only certain people answer certain questions. All
others would be asked to skip ahead to another question. While it is almost impossible to
ensure that everyone will follow the instructions, leave nothing to chance. State explicitly
what the "rules" are, and use graphic devices to emphasize what they are to do.
The skip instruction is bolded, and the contingent questions are numbered differently
(4a,
4b)
and
indented.
Note that 4a really asks two questions at once--that's OK.
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Attitudes
Attitude measurement is a specialized field unto itself. Even the experts have yet to
agree on the best methods. You may wish to include a section on attitudes, but make
sure you know how you are going to present the results and how this data will either 1)
help you with your decision making, or 2) help a prospective minister better understand
you.
To begin with, be crystal clear what the underlying scale is that you are measuring.
There are other dimensions, but you will probably be best off asking about the degree of
agreement-disagreement with a series of statements. Again, there are many rules for
good research practice. Among them:
Express only one major idea in a statement. Something like "Our minister must have
high ethical standards and be a riveting speaker" is called double-barreled or simply
"bad."
•

•
•
•

•

Use statements about which reasonable people could disagree. If 99% strongly
agree, you've wasted time. Ditto if the question is written in such a way as to
imply that there is a "right" (or PC) answer.
Keep the statements as clear, short and direct as possible. While there is some
danger of over-simplification, this is no place for academic prose.
Avoid using statements that say virtually the same thing.
Keep the questions inside a common domain, or at least group them by general
topic. For instance, you wouldn't stick in a question about air-conditioning the
social hall with several others on spiritual practices.
Be sure that the scale you are using (agreement-disagreement usually) actually
fits the text of the statement. "I live within five miles of the church" would be a
dumb item--it calls for a simple yes/no answer, and is not even an attitude. But I
have seen such items used!
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You can do worse than offering the five familiar answer categories shown below. Some
statisticians would be squeamish, but many other researchers are quite comfortable
assigning numeric values of "5" for strongly agree and "1" for strongly disagree. My
example uses check boxes, though some would have survey participants circle numbers
instead. What you do not want to do is ask people to write in numbers (1-5) or codes like
"A" or "SD."
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9) How to conduct an interview
[sourc e: http://stringers.media.mit.edu/interview.htm]
Interviews have four stages that precede the writing of a story:
• arrangements,
• preparation,
• the actual interview and
• the reconstruction.

Arrangements
Spontaneous interviews, except in connection with breaking news, seldom contribute to
thoroughness. Once you have decided to interview someone, call in advance to make an
appointment. Identify yourself by your name and the name of your publication. If you
feel the need to do so or are asked to describe what the story is about, be brief and
general. The shape of the story might change as you continue your reporting. If you are
interviewing several persons in connection with your story, interview the principal person
last, because you will be better prepared based on what you learn from the earlier
interviews.

Preparation
Do as much research as possible in advance on the person and/or topic you are working
on. Sources might include the library, public records, the internet and people you know
who can provide background information. Prepare your questions in advance in writing
and bring them to the interview. Refer to them but don't show them to the interviewee,
because it creates too formal an atmosphere. Ask other questions as they might arise,
based on what the interviewee says or something new that might come to you on the
spur of the moment. Bring two pencils (or pens) and paper. A stenographer's notebook is
usually easier to handle than a large pad but use whatever is comfortable. Bring a tape
recorder if you can but be sure to get the permission to use it from the person you are
interviewing. You also should take notes, because it will help in the reconstruction phase,
and, yes, tape recorders fail occasionally.

The interview
It is inadvisable to launch right into the interview unless you are only being given a few
minutes. Some casual conversation to start with will relax both of you. Questions should
be as short as possible. Give the respondent time to answer. Be a good listener. If he or
she prattles on, it is appropriate to move on as politely as you can. You might say
something such as: "Fine, but let me ask you this". Try to draw out specifics: How long,
how many, when, etc.? Absorb the atmospherics of the locale where the interview takes
place, with particular attention to what might be a reflection of the interviewee's
personality and interests, such as photos of children or bowling trophies or a paperlittered desk or a clean one, etc. Note characteristics of the interviewee that might be
worth mentioning in your story, such as pacing, looking out the window to think, hand
gestures and the like. Invite the person to call you if she/he thinks of anything pertinent
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after the interview. It often happens, so be sure to provide your name, email address
and phone number on a card or piece of paper before you leave. If that person has a
secretary, be sure to get that person's name and telephone number, too, in case there is
some detail that needs followup and, again, leave information as to how you may be
contacted. If a photo is needed and is not taken during the interview, be sure to make
arrangements then to have one taken at a later time.

Reconstruction
As soon as it's practical after the interview, find a quiet place to review your handwritten
notes. In your haste while taking notes, you may have written abbreviations for words
that won't mean anything to you a day or two later. Or some of your scribbling may need
deciphering, and, again, it is more likely you'll be better able to understand the scribbles
soon after the interview. Underline or put stars alongside quotes that seemed most
compelling. One star for a good quote, two stars for a very good one, etc.. It will speed
the process when you get to the writing stage. One other thing to look for in your
notes: the quote you wrote down might not make a lot of sense, unless you remember
what specific question it was responding to. In short, fill in whatever gaps exist in your
notes that will help you better understand them when writing.
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10) Excel: the basics
This handout introduces the basic features of Microsoft Excel, a spreadsheet program on
Macintoshes and on computers running Microsoft Windows. The handout covers entering
and editing data, formatting, formulas, page setup, and printing spreadsheets.

Starting Excel
You can start Excel by:

1. Double-clicking on the Microsoft Excel application icon. This application is usually in
a folder called Excel. An alias for this icon appears on the desktop of the computers in the
Student Microcomputer Facility.
2. Double-clicking on the icon of any Excel document. When you double-click an
Excel document, Excel opens with the document already loaded.

Exploring the Excel Interface
Components of the Excel Window
Besides the usual window components (close box, title bar, scroll bars, etc.), an Excel
window has several unique elements identified in the figure below.
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Standard Toolbar
The Standard toolbar, located beneath the menu bar, has buttons for commonly
performed tasks like adding a column of numbers, printing, sorting, and other
operations. Excel let's you customize the toolbar or even display multiple toolbars at the
same time. The Standard Excel XP toolbar appears in the figure below.

Formatting toolbar
The Formatting toolbar, located beneath the Standard toolbar bar, has buttons for
various formatting operations like changing text size or style, formatting numbers and
placing borders around cells.

Formula bar
The formula bar is located beneath the toolbar at the top of the Excel worksheet. Use the
formula bar to enter and edit worksheet data. The contents of the active cell always
appear in the formula bar. When you click the mouse in the formula bar, an X and a
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check mark appear. You can click the check icon to confirm and completes editing, or the
X to abandon editing.

Name box
The Name box displays the reference of the selected cells.

Row and column headings
Letters and numbers identify the rows and columns on an Excel spreadsheet. The
intersection of a row and a column is called a cell. Use row and column headings to
specify a cell's reference. For example, the cell located where column B and row 7
intersect is called B7.

Active cell
The active cell has a dark border around it to indicate your position in the worksheet. All
text and numbers that you type are inserted into the active cell. Click the mouse on a cell
to make it active.

Fill handle
The lower right corner of the active cell has a small box called a Fill Handle. Your mouse
changes to a cross-hair when you are on the Fill Handle. The Fill Handle helps you copy
data and create series of information. For example, if you type January in the active cell
and then drag the Fill Handle over four cells, Excel automatically inserts February, March,
April and May.

Worksheet tabs
An Excel workbook consists of multiple worksheets. Use the worksheet tabs at the
bottom of the screen to navigate between worksheets within a workbook.
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Working with Excel documents
Opening and Closing Documents
To open an existing Excel workbook, choose Open from the File menu or click the
Open tool on the toolbar.
Excel will display the Open dialog box, which is similar in appearance and function to the
Save As dialog box. It contains a File Name: box for you to type a file name or file
specification, a Look In: box to designate a location, and a drop-down menu of file types.

To open a file, select the appropriate location by clicking on the down pointing arrow next
to the Look In: selection box. Excel will display all Excel files found there. Select the file
you wish to open and click Open to open the file.
Saving a Document
The lower right corner of the active cell has a small box called a Fill Handle. Your mouse
changes to a cross-hair when you are on the Fill Handle. The Fill Handle helps you copy
data and create series of information. For example, if you type January in the active cell
and then drag the Fill Handle over four cells, Excel automatically inserts February, March,
April and May.
To save an untitled Excel workbook, from the File menu choose Save As or click the
Save button on the toolbar (shown at right). The Excel Save As dialog box is the same as
the Open dialog box above except it is labeled "Save As"
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The Save As dialog box contains a text box for you to type a specific filename, a "Save
File as Type:" box to save your workbook in a different format that other programs can
read, a selection box to designate the folder and drive in which to save the file, and a
"Places Bar" that offers other locations to save your file.
Difference between Save As and Save
Notice on the File menu there is a Save command and a Save As command. Use Save to
save an existing workbook with the same name in the same location. Use Save As when
you want to save a file with a different name or save it in a different location. For
example, suppose you are working on a workbook called BUDGET.XLS. After you edit the
workbook, you should save it again using the Save command. The Save command will
replace the copy on the hard drive with what is in memory (what you see on your
screen). At the end of the day, you might want to save a copy of the file on a diskette to
take home. Choose Save As and select the proper drive in the Save As dialog box. This
will create another copy of the file on your diskette.
Creating a New Workbook
The lower right corner of the active cell has a small box called a Fill Handle. Your mouse
changes to a cross-hair when you are on the Fill Handle. The Fill Handle helps you copy
data and create series of information. For example, if you type January in the active cell
and then drag the Fill Handle over four cells, Excel automatically inserts February, March,
April and May.
If you are already in Excel and you want to create a new workbook, choose New from
the File menu or click the New tool on the toolbar. If you choose New from the file menu
the Task Pane will open on the right side of the Excel worksheet. To create a blank
workbook, click Blank Workbook in the Task Pane, and a new workbook opens.
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Managing Multiple Workbooks
Excel enables you to have more than one workbook open simultaneously. Each open
workbook appears on the Window menu. The document with the check next to it is the
active document. To switch to another document, simply choose that document from
the Window menu.
To navigate between worksheets within a workbook, click the worksheet tab you want to
activate. Double-click a worksheet tab to change its name.

Entering and Editing Data
Entering Data
You can enter text, numbers and dates in an Excel worksheet. In Excel¹s terminology,
numbers and dates are called values and text is referred to as a label. To enter data of
any type, click on the cell you want to contain that data, and then type the information
you want in the cell. When you begin typing, your data also appears in the formula bar.
When you have finished typing the data for the active cell, press the Return or Enter key.
Editing Data
The easiest way to edit the contents of a cell is to select the cell and then retype the
entry. The new entry replaces the old contents. For example, to change the number in
cell B6 to 199, select cell B6, type 199 and press Return. This method works well with
numbers, but is more difficult when editing long text labels or formulas.
The formula bar gives you more flexibility while editing. When the mouse pointer moves
into the formula bar, it changes shape to an I-beam, signifying that you can enter or edit
text. Text in the active cell appears in the formula bar and you can edit it there. Use the
mouse to select the text you want to change in the formula bar and then type the new
text. Excel automatically replaces what is selected. Don't forget to press the Return key
when you finish editing a cell.
You can also edit labels and values directly in cells. Double-click on the cell you want to
edit. This puts an insertion point in the cell. Edit the contents of that cell the same way
you would using the formula bar.
Moving the Active Cell
Cell selection and movement around the worksheet are similar operations in Excel. To
select a given cell or make it active, simply click on that cell. Use the mouse or the arrow
keys to move around the worksheet. For example, if you press the right arrow key twice
you move two cells to the right.
Refer to the table below for additional information on using the keyboard to navigate a
worksheet.
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To move

Press this key

One cell left

Left Arrow

One cell right

Right Arrow

One cell up

Up Arrow

One cell down

Down Arrow

To top of worksheet (cell A1)

Control Home

To last cell containing data

Control End

To end of data in a column

Control Down Arrow

To beginning of data in a column

Control Up Arrow

To end of data in a row

Control Right Arrow

To beginning of data in a row

Control Left Arrow

Go To Command
A quick way to move a large distance on a worksheet is with the Go To command on
the Edit menu. When you select the Go To command, a dialog box prompts you to
identify the cell. Enter the cell reference and click OK or press Return.
Clearing Cell Contents
To clear the contents of a cell choose Clear from the Edit menu. Then, select what you
want to clear from the cell: All, Formats, Contents, or Notes. Most frequently you will
want to clear the Contents of a cell. Pressing theDelete key also clears the contents of
cells.
Undoing Mistakes
If you make a terrible mistake and you accidentally delete important data. Use
the Undo command on the Editmenu or the Undo tool to correct the mistake.
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Copying and Moving Data
Copy selected data from one cell to another with the Copy and Paste commands, or with
the Drag and Drop procedure. If you want to move data instead, use
the Cut and Paste commands, or the Drag and Drop procedure.
These commands and procedures are described below.
Cut
The Cut command extracts the selected data and puts it on the
Clipboard, a temporary storage area. The contents of the
Clipboard are overwritten with each copy or cut.
Copy
The Copy command puts a copy of the selected data on the
Clipboard.
Paste
The Paste command inserts the Clipboard¹s contents into the
active cell. Selected data is replaced by pasted text.
Drag and Drop
This procedure does not involve the Clipboard and works best
when moving data a short distance. To move cells, position the
mouse on the cell borders. Wait until the mouse changes to a
left-pointing arrow. When the mouse is this shape, press and
drag the data to the new location.

Formatting Data
Changing formats using the toolbar
In Excel, you can change text fonts and styles in the worksheet. Excel has a Formatting
toolbar to simplify basic formatting tasks. The Formatting toolbar appears in the figure
below.

The formatting toolbar has several tools you can use to change formats. The B button
makes cells bold, the I button italicizes cells and the U button underlines. Use these
buttons to turn formats off as well as on. For example, if cells are bold and you want to
turn off that format, select the cells and click the B button. The toolbar also has buttons
to change font and size.

‐48‐

Sana’a University
Republic of Yemen
Font tab in Format Cells
The formatting toolbar offers quick access to varying text formats. For a more complete
selection of formatting options, use the Font tab in the Format Cells dialog box.

In the Font section you can select Font, Size, Style, Color and Effects. Notice the Preview
area in the dialog box. This shows a preview of the font and style you select before you
click the OK button.
Alignment
By default, Excel left-aligns labels and right-aligns values in a worksheet. You can change
cell alignment using the toolbar or the Format Cells command.
The toolbar has text alignment icons next to the bold and italic icons. You can left-align,
right-align, or center text within a cell using these buttons. Select the cell(s) you want to
align and click the appropriate alignment button on the toolbar.
The toolbar also has a button that will center a label over a range of cells, for
example centering a title over a report. To center data over a range of cells, select the cell
you want to center and the columns you want to center it over and click the Center over
Cells button (shown at right).
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Format Alignment command
You can also change the alignment of data within cells using the Alignment section of the
Format Cells dialog. This dialog box also has options to change the orientation of text
(i.e. sideways or vertical) and a box to wrap text within a cell.
Changing Numeric Formatting
To change the format of a number, choose the Cells command from the Format menu. In
the Format Cells dialog box, Excel displays different tabs for various formatting types. To
change numeric formats, click the Number tab. Select the category you want and then
the actual format. For example, to display numbers as currency with two decimal places,
select the Currency category, enter 2 for the number of decimal places, and select the
appropriate currency symbol. Or to display a number as a percentage, choose the
Percentage category and select the number of decimals you want to display.

Placing borders around cells
The toolbar has a button for placing borders around cells. You can also use the
Border section of the Format Cells dialog box, which provides more options. Select the
cells you want a border on and choose the desired format from either the toolbar or the
Format Cells dialog box.
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Shading cells
To apply a specific pattern or color to a range of cells, use the Patterns section of the
Format Cells dialog box. The sample area in the Patterns dialog box displays what the
selected colors and patterns will look like. You can also apply a solid color using the Fill
Color tool on the Formatting toolbar.
Changing column width with the Format menu
To change column width using the Format menu, select the column or columns you wish
to change and choose Column then Width. In the Column Width dialog box, type a
number for the width of the column. The number represents the number of characters
that can fit in the cell. The default column width is 10, which means a column is wide
enough for ten, Helvetica 10-point characters. Choose Best Fit to automatically widen a
column to accommodate the widest label, or click the Hide button to hide the column
completely. Hiding columns is useful when you have data that you do not want to print.
* Changing row height is similar to changing column width. Select the row(s) you
wish to change and choose Row then Height from the Format menu.
Changing column widths by dragging column borders
You can change column widths by dragging column borders with the mouse. Move the
mouse pointer to the right hand border of the column you wish to change. The mouse
pointer will change shape to a left and right pointing arrow as seen below.

Click and drag the mouse to adjust the column width. Note that when you are adjusting
the width in this way, a numeric width indicator appears in the upper left part of the
formula bar.

Formulas and Functions

Formulas and functions that perform calculations are the true power of spreadsheets.
Formulas
To build a formula, first select the cell in which you want the results to appear. In Excel,
all formulas start with the = sign. After the = sign, type the cells you want to add or
subtract along with the mathematical operation you wish to perform. For example, to add
the January sales in the worksheet below, the formula would be =B3+B4+B5. If you
want to subtract February Widget Sales from January Widget sales, the formula would be
=B3-C3.
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Building many formulas can quickly become tedious. Fortunately, the Copy command
described earlier also works with formulas.
Copying Formulas
The easiest way to copy a formula is with the Fill Handle in the lower right corner of the
cell. Create your initial formula and then position the mouse on the Fill Handle. When the
mouse changes shape to a cross-hair, press and drag over the adjacent cells you want to
copy the formula to.
SUM( ) function
The SUM( ) function is probably the most common function in Excel. It adds a range of
numbers. To build a SUM( ) function, begin by typing the = sign; all functions begin with
the = sign. Next type the word SUM followed by an open parenthesis. You must now tell
Excel which cells to sum. Using the mouse, click and drag over the range of cells you
wish to add. A dotted outline will appear around the cells and the cell range will be
displayed in the formula bar. When you have the correct cells selected, release the
mouse button, type a closing parenthesis and press the <Enter> key.
If you do not want to use the mouse, type in the references of the cells you want to sum.
For example, to add cells B3 through B5, type =SUM(B3:B5). Excel interprets B3:B5 as
the range of cells from B3 to B5.
AutoSum button
In Excel, the standard toolbar has a button that simplifies adding a column or row of
numbers. The AutoSum button, which resembles the Greek letter Sigma (shown at right),
automatically creates a SUM( ) function. When you click the AutoSum button Excel creates
a sum function for the column of numbers directly above or the row of numbers to the left.
Excel pastes the SUM( ) function and the range to sum into the formula bar. If the range is
not correct, simply select the proper range with your mouse on the worksheet. When you
have the correct range entered, press the <Enter> key to complete the function.
Using the Insert Function Button
The Insert Function Button is located by the Formula Bar.
Click the Insert funtion button in to activate the Insert Function dialog window.
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First, choose the Function Category you are interested in from the select a category drop
down menu.

Then select the function you want in that category. When you have selected the proper
function click OK.
In the Function Arguments dialog box you specify the cells the function will operate on,
which are called its arguments. Select the cells with the mouse and click OK. Notice the
creation of the function in the formula bar.
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Adjusting Page Setup settings

Before you actually print a worksheet, you should provide Excel information about
margins, headers, footers, and page orientation. You change these settings using the
Page Setup option on the File menu.
The Page Setup dialog box, shown below, has controls for margins, page orientation,
headers and footers and whether gridlines and row and column heading should be
printed.

To change page margins
To change your margins, click the Margins tab, and enter the measurement for your
margin, in inches, in the appropriate text box.
To change page orientation
If you want to change the orientation of the page from portrait (vertical) to landscape
(horizontal) click the appropriate button in the Page Orientation section of the Page tab.
To change the header or footer
A header is text that prints at the top of each page. A footer is text that prints at the
bottom of each page. Headers and footers often include the name of the file being
printed or an alternative title, the date, page number, or additional descriptive
information. To change the header or footer, click on the Header /Footer tab in the Page
Setup dialog box. The current header and footer will appear at the top and bottom of the
dialog box respectively. Click the Custom Header or Custom Footer button to change the
existing header or footer.
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The header and footer are divided into three sections (left, center and right). Press
<Tab> or <Shift Tab> to move from section of the header or footer to another.

Printing
Print preview
Before you actually print, it¹s a good idea to preview your output on the
screen.Choose Print Preview on the File menu to preview your output on screen. Excel¹s
Print Preview screen displays how the document will print on the page, but it is difficult to
actually read the text. Notice that the mouse pointer takes the shape of a magnifying
glass. You can enlarge the printed image by clicking the Zoom button or by using the
magnifying glass. Simply click the magnifying glass on a part of the page you want to
enlarge.
The Print Preview screen also has several buttons at the top of the screen for making
adjustments. For example, the Setup button opens the Page Setup dialog box and the
Margins button lets you change page margin and column widths to fit more information
on one page.
If you are satisfied with how the output appears in the Print Preview screen, the Print
button lets you send your output directly to the printer.
Sending your workbook to the printer
Choosing the Print option on the File menu or clicking the Print button on the toolbar
opens a dialog box that lets you change print settings and specify the number of copies to
print. The Print dialog box appears below.
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Within the Print dialog box, you can select what you want to print, how many copies and
which pages. For example, if you only want to print the selected cells, or the entire
worksheet you can choose those options.
Getting Help

In the Help System, any topic that has additional information is underlined. To read the
information about an underlined topic, click on the topic. The Help System automatically
switches to information about the selected topic.
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To expand to the full Help window, click the Show icon.
The Contents Tab
The Contents Tab is a listing of ³books² containing one or more Help topics and even
some subbooks. You can open any of these books by double-clicking on it to get
information about a topic.
The Answer Wizard Tab
Using the Answer Wizard is similar to using the Office Assistant. You can type in your
question or the term you¹d like help on, click Search and a list of topics will be displayed.
Information on the topic will appear in the right-hand window.
The Index Tab
The Index is an alphabetical listing of key words found in the Help topics. You can either
type a word in the first text box or select a topic from the scrolling list displayed below.
When you have selected a topic click on the Search button. A list of related topics is
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displayed in the third text box. Select the topic of your choice and information about that
topic will appear in the right-hand window.

‐58‐

Sana’a University
Republic of Yemen

11) Report writing
[source: http://startup.curtin.edu.au/study/writing/report.cfm]
Content:
• What is a report?
•
•
•

Characteristics of an effective report
Report structure
Procedure for report writing

What is a report?
A report is a structured written presentation directed to interested readers in response to
some specific purpose, aim or request. There are many varieties of reports, but generally
their function is to give an account of something, to answer a question, or to offer a
solution to a problem.

Characteristics of an effective report

An effective report is:
• appropriate to its purpose and audience;
• accurate;
• logical;
• clear and concise; and
• well organised with clear section headings.

Report structure

One important advantage that a report has over other written communication is
that it follows a standardized format. This enables readers to find and focus on
specific pieces of information. Most reports are modeled on the following
structure (modified where necessary).
1) Transmittal document
2) Title page
3) Table of contents
4) Abstract/Executive Summary
5) Introduction
6) Discussion
7) Conclusions
8) Recommendations
9) Bibliography

Procedure for report writing

The following is a suggestion as to how you might proceed in compiling and
presenting a report. There are three stages:
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•
•
•

Planning
Writing
Formatting, revising and proof-reading

Stage One: Planning

1. Defining the purpose

- read the brief carefully
- identify key words
- make sure you know what's really being asked

2. Defining the audience - determine your audience's level of understanding
- determine what your audience needs to know
3. Establishing
parameters

- determine the scope and level of detail required
- determine the length of the report and what can be
covered in that length

4. Gathering information - make sure the information you gather is relevant,
contemporary and factually correct
- make sure that you transcribe facts and figures
correctly

Stage Two: Writing

Write the report in three stages:
• Write the body
• Write the abstract/executive summary
• Write the supplementary material

1. Writing the body
There are four components of the body of the report: the introduction, the discussion,
the conclusion and the recommendations.

Introduction
The introduction leads into the main subject matter by giving the necessary background
of the report, its aims, premises, scope, limitations, approach intended audience,
possible benefits and any instructions that may be useful for the reader. If specialist
terms are used in the report, define them clearly.
It puts the discussion in perspective, explains why the report is necessary and gives
background information on the subject matter.

Discussion
The discussion is the main body of the report. Use headings and sub-headings. It
describes, analyses, interprets and evaluates the procedures, data, findings,
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relationships, visual material, methodology and results in the report. This material should
be presented in an order that leads logically towards the conclusions and
recommendations.
In writing the discussion section of the body, you should:
• pitch at appropriate level
• organise material logically
• use clear, concise language
• give concrete examples
Conclusion
Conclusions are drawn from evidence, analysis, interpretation and evaluation presented
in the discussion. No new material should be introduced; the conclusions should follow
logically from the Discussion. The Conclusions section should give:
• Conclusions
• Key points
• Main findings

Recommendation
The Recommendation section (when used - not all reports give recommendations) should
present your informed opinions, suggestions, possible actions to be taken, applications
and recommendations arising from a rational consideration of the discussion and
conclusions.
• Be definite
• Be perceptive
• Be imaginative
• Be rational

2. Abstract/executive summary
Once the body of the report is written, write the abstract. The abstract (also known as
the Executive Summary) is a concise summary presentation of the essential elements of
the report, from the introduction through to and including the recommendations. It
should be independent (can be read on its own), comprehensive (covers all the main
points), clear and concise. As a general rule it should be short, only 10-15% of the length
of the report, and should be written in full sentences and paragraphs. It should include a
summary of the following:
• Purpose
• Scope
• Achievements
• Main points
• Conclusions
• Recommendations
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3. Writing the supplementary material

Transmittal document
The transmittal document is not part of the report, but accompanies the report. In letter,
memo, or minute form, it personalises the report for a specific reader and calls attention
to those items or sections in the report which are of particular interest to that person.

Title page
Identifies the report with the following information:
• Title
• Author's name, position and qualifications
• Authority for report
• Place of origin
• Date
Table of contents
The table of contents shows the section titles and major headings listed in order of
appearance and indicates page locations. Standard page numbering begins with the
Introduction. The Abstract or Executive Summary is usually numbered with lower case
Roman numerals (i, ii, iii, iv, etc.)

Bibliography
The bibliography lists all publications either cited or referred to in preparing the report.
Use the Referencing System recommended by your School.

Stage Three: Formatting, revising and proof-reading
Apply the following "report checklist"
1) Have I fulfilled the purpose of the report?
2) Is it written at a level appropriate to its audience?
3) Are its facts correct?
4) Is it comprehensive?
5) Is all the included information relevant?
6) Are the layout and presentation well thought out?
7) Is the style clear, concise and professional?
8) Does the abstract summarise?
9) Does the introduction adequately introduce the discussion?
10)Is the discussion organised logically?
11)Does the conclusions section interpret, analyse and and evaluate?
12)Are the recommendations reasonable?
13)Does the table of contents correspond with the actual contents? Are page
numbers correct?
14)Have I acknowledged all sources of information through correct referencing?
15)Have I checked spelling, grammar and punctuation?
16)Have I carefully proof-read the final draft
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12) Plagiarism, referring, citing and falsification
Plagiarism: What It is and How to Recognize and Avoid It
What is Plagiarism and Why is it Important?
In college courses, we are continually engaged with other people’s ideas: we read them
in texts, hear them in lecture, discuss them in class, and incorporate them into our own
writing. As a result, it is very important that we give credit where it is due. Plagiarism is
using others’ ideas and words without clearly acknowledging the source of that
information.

How Can Students Avoid Plagiarism?
To avoid plagiarism, you must give credit whenever you use
• another person’s idea, opinion, or theory;
• any facts, statistics, graphs, drawings—any pieces of information—that are not
common knowledge;
• quotations of another person’s actual spoken or written words; or
• paraphrase of another person’s spoken or written words.

To help you recognize what plagiarism looks like and what strategies you can use to
avoid it, select one of the following links or scroll down to the appropriate topic.
•

•
•

•

How to Recognize Unacceptable and Acceptable Paraphrases
o An Unacceptable Paraphrase
o An Acceptable Paraphrase
o Another Acceptable Paraphrase
Plagiarism and the World Wide Web
Strategies for Avoiding Plagiarism
Terms You Need to Know (or What is Common Knowledge?)
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How to Recognize Unacceptable and Acceptable Paraphrases
Here’s the ORIGINAL text, from page 1 of Lizzie Borden: A Case Book of Family
and Crime in the 1890s by Joyce Williams et al.:
The rise of industry, the growth of cities, and the expansion of the population were the
three great developments of late nineteenth century American history. As new, larger,
steam-powered factories became a feature of the American landscape in the East, they
transformed farm hands into industrial laborers, and provided jobs for a rising tide of
immigrants. With industry came urbanization the growth of large cities (like Fall River,
Massachusetts, where the Bordens lived) which became the centers of production as well
as of commerce and trade.
Here’s an unacceptable paraphrase that is plagiarism:
The increase of industry, the growth of cities, and the explosion of the population were
three large factors of nineteenth century America. As steam-driven companies became
more visible in the eastern part of the country, they changed farm hands into factory
workers and provided jobs for the large wave of immigrants. With industry came the
growth of large cities like Fall River where the Bordens lived which turned into centers of
commerce and trade as well as production.
What makes this passage plagiarism?
The preceding passage is considered plagiarism for two reasons:
•
•

the writer has only changed around a few words and phrases, or changed the
order of the original’s sentences.
the writer has failed to cite a source for any of the ideas or facts.

If you do either or both of these things, you are plagiarizing.

NOTE: This paragraph is also problematic because it changes the sense of several
sentences (for example, "steam-driven companies" in sentence two misses the original’s
emphasis on factories).
Here’s an acceptable paraphrase:
Fall River, where the Borden family lived, was typical of northeastern industrial cities of
the nineteenth century. Steam-powered production had shifted labor from agriculture to
manufacturing, and as immigrants arrived in the US, they found work in these new
factories. As a result, populations grew, and large urban areas arose. Fall River was one
of these manufacturing and commercial centers (Williams 1).
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Why is this passage acceptable?
This is acceptable paraphrasing because the writer:
•
•

accurately
relays
the
information
uses her own words.
lets her reader know the source of her information.

in

the

original

Here’s an example of quotation and paraphrase used together, which is also
acceptable:
Fall River, where the Borden family lived, was typical of northeastern industrial cities of
the nineteenth century. As steam-powered production shifted labor from agriculture to
manufacturing, the demand for workers "transformed farm hands into industrial
laborers," and created jobs for immigrants. In turn, growing populations increased the
size of urban areas. Fall River was one of these hubs "which became the centers of
production as well as of commerce and trade" (Williams 1).

Why is this passage acceptable?
This is acceptable paraphrasing because the writer:
•
•
•

records the information in the original passage accurately.
gives credit for the ideas in this passage.
indicated which part is taken directly from her source by putting the passage in
quotation marks and citing the page number.

Note that if the writer had used these phrases or sentences in her own paper without
putting quotation marks around them, she would be PLAGIARIZING. Using another
person’s phrases or sentences without putting quotation marks around them is
considered plagiarism even if the writer cites in her own text the source of the
phrases or sentences she has quoted.
Plagiarism and the World Wide Web
The World Wide Web has become a more popular source of information for student
papers, and many questions have arisen about how to avoid plagiarizing these sources.
In most cases, the same rules apply as to a printed source: when a writer must refer to
ideas or quote from a WWW site, she must cite that source.
If a writer wants to use visual information from a WWW site, many of the same rules
apply. Copying visual information or graphics from a WWW site (or from a printed
source) is very similar to quoting information, and the source of the visual information or
graphic must be cited. These rules also apply to other uses of textual or visual
information from WWW sites; for example, if a student is constructing a web page as a
class project, and copies graphics or visual information from other sites, she must also
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provide information about the source of this information. In this case, it might be a good
idea to obtain permission from the WWW site’s owner before using the graphics.
Strategies for Avoiding Plagiarism
1. Put in quotations everything that comes directly from the text especially when taking
notes.
2. Paraphrase, but be sure you are not just rearranging or replacing a few words.
Instead, read over what you want to paraphrase carefully; cover up the text with your
hand, or close the text so you can’t see any of it (and so aren’t tempted to use the text
as a “guide”). Write out the idea in your own words without peeking.
3. Check your paraphrase against the original text to be sure you have not accidentally
used the same phrases or words, and that the information is accurate.
Terms You Need to Know (or What is Common Knowledge?)
Common knowledge: facts that can be found in numerous places and are likely to be
known by a lot of people.
Example: John F. Kennedy was elected President of the United States in 1960.

This is generally known information. You do not need to document this fact.
However, you must document facts that are not generally known and ideas that interpret facts.
Example: According the American Family Leave Coalition’s new book, Family Issues and
Congress, President Bush’s relationship with Congress has hindered family leave
legislation (6).
The idea that “Bush’s relationship with Congress has hindered family leave legislation” is
not a fact but an interpretation; consequently, you need to cite your source.
Quotation: using someone’s words. When you quote, place the passage you are using in
quotation marks, and document the source according to a standard documentation style.
The following example uses the Modern Language Association’s style:
Example: According to Peter S. Pritchard in USA Today, “Public schools need reform but
they’re irreplaceable in teaching all the nation’s young” (14).
Paraphrase: using someone’s ideas, but putting them in your own words. This is
probably the skill you will use most when incorporating sources into your writing.
Although you use your own words to paraphrase, you must still acknowledge the source
of the information.
[Source: Indiana University: http://www.indiana.edu/~wts/pamphlets/plagiarism.shtml]
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13) Presenting
Making a good oral presentation is an art that involves attention to the needs of your
audience, careful planning, and attention to delivery. This page explains some of the
basics of effective oral presentation. It also covers use of notes, visual aids and computer
presentation software.

The audience
Some basic questions to ask about an audience are:
Who will I be speaking to?
What do they know about my topic already?
What will they want to know about my topic?
What do I want them to know by the end of my talk?
By basing the content and style of your presentation on your answers to these questions,
you can make sure that you are in tune with your audience. What you want to say about
your topic may be much less important than what your audience wants to hear about it.

Planning your presentation
In an effective presentation, the content and structure are adjusted to the medium of
speech. When listening, we cannot go back over a difficult point to understand it or easily
absorb long arguments. A presentation can easily be ruined if the content is too difficult
for the audience to follow or if the structure is too complicated.
As a general rule, expect to cover much less content than you would in a written report.
Make difficult points easier to understand by preparing the listener for them, using plenty
of examples and going back over them later. Leave time for questions within the
presentation.
Give your presentation a simple and logical structure. Include an introduction in which
you outline the points you intend to cover and a conclusion in which you go over the
main points of your talk.

Delivering your presentation
People vary in their ability to speak confidently in public, but everyone gets nervous and
everyone can learn how to improve their presentation skills by applying a few simple
techniques.
The main points to pay attention to in delivery are the quality of your voice, your rapport
with the audience, use of notes and use of visual aids.
Voice quality involves attention to volume, speed and fluency, clarity and pronunciation.
The quality of your voice in a presentation will improve dramatically if you are able to
practise beforehand in a room similar to the one you will be presenting in.
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Rapport with the audience involves attention to eye contact, sensitivity to how the
audience is responding to your talk and what you look like from the point of view of the
audience. These can be improved by practising in front of one or two friends or videotaping your rehearsal.

Effective use of notes
Good speakers vary a great deal in their use of notes. Some do not use notes at all and
some write out their talk in great detail. If you are not an experienced speaker it is not a
good idea to speak without notes because you will soon lose your thread. You should also
avoid reading a prepared text aloud or memorising your speech as this will be boring.
The best solution may be to use notes with headings and points to be covered. You may
also want to write down key sentences. Notes can be on paper or cards. Some speakers
use overhead transparencies as notes. The trick in using notes is to avoid shifting your
attention from the audience for too long. Your notes should always be written large
enough for you to see without moving your head too much.

Visual aids
Visual aids help to make a presentation more lively. They can also help the audience to
follow your presentation and help you to present information that would be difficult to
follow through speech alone.
The two most common forms of visual aid are overhead transparencies (OHTs) and
computer slide shows (e.g. PowerPoint). Objects that can be displayed or passed round
the audience can also be very effective and often help to relax the audience. Some
speakers give printed handouts to the audience to follow as they speak. Others prefer to
give their handouts at the end of the talk, because they can distract the audience from
the presentation.

[source: http://ec.hku.hk/epc/presentation/]

‐68‐

Sana’a University
Republic of Yemen

Annexes

‐69‐

